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  Welcome to another issue of Full Circle Magazine.


  By the time you read this, KDE 4.1 will be unleashed upon the masses. I've been following KDE 4 since 4.0, and I can honestly say: it's come on in leaps and bounds.
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          Shown left is my current desktop, KDE 4.1 RC1, with Twitter plasmoid top right, a couple of post-it notes, middle right (yes, I am that forgetful!), a folder view, middle top, and some shortcuts, top left. Not only does KDE 4.1 look lovely, but it's far more usable now than in its 4.0 incarnation. So, if you haven't given KDE 4 a try lately (or didn't like 4.0) give it a whirl. I think you'll be impressed.

        
      

    
  


  Speaking of Twitter, you can follow us at: twitter.com/fullcirclemag, where the team will twitter their hearts out about what they are up to in the world of Full Circle.

  

  I hope you enjoy this issue, and remember: we're only an email away so feel free to let us know what you like (or dislike) and what you want to see in future issues. Contact addresses are on the last page of this issue.

  

  All the best,

  

  Ronnie

  Editor, Full Circle Magazine

  ronnie@fullcirclemagazine.org


  

  



  Command & Conquer


  Written by Robert Clipaham


  Last month we showed you how to stay safe using a command line. Now that you know this, you can start using it to your advantage! Over the next few issues, we'll show you the basics of file management, which will be of use later on when doing more advanced things.

  

  The first command in this issue will just prove a statement from the start of last month's article, "you are in your home directory". Whenever you see ~ this means your home directory, so to prove this, type (in a terminal):

  

  pwd

  

  I get this output:

  

  $ pwd

  /home/robert

  

  Of course this will display your home directory, rather than mine. But what use is this to you? What does it mean to be 'in your home directory'? Any commands you execute will be run in the current directory. This won't mean much for now, but it will make all the difference later on. One command that uses your current directory is 'ls', which will give you a list of files in the directory you specify, or in the current directory if you don't specify one.

  

  It's not always useful to be in your home directory though, so let's move away. To do this, we use the change directory command, cd.

  

  $ cd ~/Documents

  

  If you now type 'pwd', you will see you are now in your documents directory. The '~/' was not needed for that command although it can be a handy shortcut to save time. In this example, you were already in your home directory, so 'cd Documents' would have worked. If you were in another directory though, say '/home/robert/Pictures/2007/December/Christmas' for example, it would take a long time to change to the documents directory without '~/'. However, now that you are in your Documents directory, how do you move back to your Home directory? There are several ways do to this.

  

  $ cd

  $ cd ..

  $ cd ~/

  $ cd /home/robert

  

  These all do the same thing if you are in your Documents directory. 'cd' with no arguments will always take you to your home folder. 'cd ..' takes you to your previous directory, so here we moved from '/home/robert/Documents' to the previous directory, '/home/robert'. The third uses the ~ shortcut, and can be used with or without the trailing '/'. The final command uses the full path, which will always take you to the exact location, providing it exists.

  

  Now for some time saving! Rather than typing out a long directory like '~/Pictures/2007/December/Christmas', you can just type the first few letters!

  

  $ cd ~/Pi<tab>

  

  Replace <tab> with you pressing your tab key, and notice how it automatically changes to Pictures? You can use this technique with most directories to save time.

  

  Troubleshooting

  

  You may have encountered some problems performing these simple commands. Don't worry though, it is probably something very simple. The first problem you may have encountered probably happened when you tried changing to the Documents directory.

  

  -bash: cd: documents: No such file or directory

  

  Everything you enter at the command line is case sensitive! Documents and documents are two completely different directories in the eyes of the terminal, so make sure you have the correct capitalization! You may also have had this error if you don't have a Documents directory because, for example, you have deleted it. The other error you may have encountered is when trying to use tab complete. If your computer gave a beep when you hit tab, it can mean one of two things. The first is that the directory doesn't exist. If the directory doesn't exist, it won't be able to tab complete it! The other possiblity is that you have multiple directories starting with Pi in your home directory. If this is the case then hit tab again, and you will get a list of possible files and directories, so you can type a few more letters and hit tab again. If there are a lot of possible matches, you will see something like:

  

  Display all 388 possibilities? (y or n)

  

  Unless you want to see them all, type 'n', then hit enter and type a few more letters to narrow down the number of possible matches.

  

  Robert Clipsham is a self confessed geek, whose hobbies include: programming/scripting, chatting on IRC and not writing his articles on time.


  

  



  How To

  Create A Separate Home Partition


  Written by Robin Catling


  If you ran the default installation of Ubuntu using the "guided" partitioning option, you probably have two partitions on your hard drive: an Ubuntu system partition and a swap partition. This is fine until you run regular backups, or upgrade to Ubuntu 8.04, or need to recover from a disaster. Then, having all your data and programs on the same partition suddenly seems like a bad idea. Don't believe the way that most file managers present the contents of your machine; /home is still part of your main filesystem. However, keeping the system (Ubuntu) and data (your own stuff) segregated on separate disk partitions has certain advantages. If I need to re-install or re-format the system partition, I can happily wipe it, knowing nothing happens to the /home folder. My backups become simpler. Upgrades get easier. If only there was a way to separate /home.

  

  There is, but this method comes with no warranties and is liable to all manner of user-goofs, so back up everything first!

  

  1. Resize your existing partitions to create space for the new /home



  Unless you have unused disk space, you will need to resize the existing filesystem partition to make room. Make sure you know how much space you currently use for /home and allow some room for growth before you start this. You can use an extra internal hard drive, but don't try this on a USB drive, kids!

  

  You will need one of the partition editors capable of on-the-fly move/resize operations leaving the disk contents in place – the Parted, Gparted, Visparted family do very well. You need to run it from an Ubuntu Live CD, Parted Magic or System Rescue CD because your existing partition needs to be unmounted to be resized and thus your computer can't be booted into your regular Ubuntu installation.

  

  If you screw up your installation, you can use the live CD to restore your old settings and, in the worst situation, at least recover your important files. Launch Parted, select your partition to resize, and then select the Resize/Move button to bring up the settings dialog box.
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  You can click-and-drag on the partition graphic to set the partition size or type a number in the New Size box; it measures in megabytes so you want a number in thousands for gigabytes. Tab out of the box to update the Parted dialog. When you're happy, click on the Resize/Move button (bottom-right) to confirm your settings. Nothing happens until you click on the Apply button in the main window.
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  This may take a while. Each section in the progress box is expandable so you can see what's happening at every stage.

  

  2. Create a new partition in the freed space

  

  Still in Parted, select the New option and specify your partition for the new /home. It uses the same dialog box.

  

  Hint: stick with one type of filesystem. If your main partition is ext3 – which is a good safe choice – then create the new partition as ext3. If you're on ext2 or Reiser, keep the new partition the same. All the Parted versions show the partitions colour-coded by type on-screen.
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  Note the partition names, making sure you know which is the old and the new. In my example

  

  hda1 is oldhome

  

  hda3 will be the newhome

  

  3. Mount old and new partitions

  

  Quit Parted. We're still using our Live CD session and we'll move things around under the temporary filesystem it creates. Open a terminal; make a new directory as a placeholder, then mount the new partition under it:

  

  sudo mkdir /mnt/newhome

  sudo mount -t ext3 /dev/hda3 /mnt/newhome

  

  Then do the same for your main filesystem partition:

  

  sudo mkdir /mnt/oldhome

  sudo mount -t ext3 /dev/hda1 /mnt/oldhome

  

  We need to use sudo for most of these commands as they need root permissions to run.

  

  4. Move the old home into the new home folder/partition

  

  Change directory into to the oldhome mountpoint:

  

  cd /oldhome

  

  Since the “/home” directory will have hard links, soft links, files and nested directories, a regular copy (cp) may not do the job completely, so we'll use a different method. Take a deep breath:

  

  sudo find . -depth -print0 | sudo cpio --null --sparse --preserve-modification-time -pvd /mnt/newhome/

  

  What this does is to string two commands together:

  

  find is a native command that follows the pattern 'find <where-to-look criteria> <what-to-do>.' The period is the end of the <where> clause, so by default look at everything in the current folder (remember we're in the /oldhome/home folder structure).

  

  -depth says search all the way to the lowest level of the folder tree

  -print0 is to include file names with spaces

  

  The pipe '|' redirects the output of the find to be the input for the cpio command which always takes its instructions from a prior command.

  

  So:

  cpio is the copy command

  --null expect to receive filenames containing spaces

  --preserve-modification-time keeps all the 'last modified timestamps' intact through the copy process.

  

  Then:

  p is for pass-through or 'by-pass the archive step' and copy direct to destination

  v is verbose - list the files copied on-screen;

  d specifies make-directories - create the corresponding folders in the destination folder.

  

  Finally the /mnt/newhome/ is the destination folder for the copied files. This copies everything while preserving the last modification timestamps.

  

  5. Unmount the /newhome new partition

  

  Having copied what we need, we unmount it in order to re-mount it in the right place later.

  

  sudo umount /mnt/newhome

  

  6. Rename the old /home as a safe backup

  

  Make sure everything has moved cleanly before this step! The folder name '/home' is a significant reserved name in the filesystem and we need to rename the old /home so that our regular Ubuntu session can't mount it when we reboot - we want it to use the new one:

  

  sudo mv /oldhome/home /oldhome/home_backup

  

  The move command 'mv' is a shorthand way to rename a file or folder. The original home is still there under a different name. Nothing deleted yet.

  

  7. Mount your new home

  

  Create a new placeholder in the filesystem where the new /home will be mounted:

  

  sudo mkdir /oldhome/home

  

  Mount the new home under this placeholder:

  

  sudo mount /dev/hda3 /home

  

  You should find all your personal files looking exactly as they did before. This is fine and dandy for the Live CD session, but now you have to make this permanent for when you reboot into your regular Ubuntu desktop. Otherwise the new home won't be mounted and you won't see your Ubuntu desktop!

  

  9. Modify fstab to make things permanent

  

  We have to modify the /etc/fstab file. Fstab is the File System Table, the quick lookup the Ubuntu kernel uses like its school register to see who's in class, what their names are and where they sit, except fstab lists drives and partitions, not school kids. The command:

  

  sudo gedit /etc/fstab

  

  opens the Gedit text editor so you can add the line for your new partition:

  

  /dev/hda3 /home ext3 nodev,nosuid 0 2

  

  This line essentially says 'mount /dev/sda3 under the mountpoint /home,' with some options. Amend this for your partition name and filesystem.

  

  If Gedit gives you trouble saving this change, then my fall-back is a character-mode text editor such as Vi or Nano, which are on the Ubuntu Live CD:

  

  sudo nano /etc/fstab

  

  Go to the bottom of the file, add the line, and then save and quit -- the key-strokes are control-o, enter, control-x.

  

  10. Reboot computer and verify

  

  Close the Live CD session, then reboot into your regular Ubuntu session. Make sure everything is working right, /home is mounted where we specified, and all folders are accessible.

  

  11. Remove the old home

  

  You've now got two copies of home on your system, so if you're satisfied the new one is good, clear out the old:

  

  sudo rm -r /old_home

  

  This deletes the original home folder and contents.

  

  What if it doesn't work?

  

  There are two real possibilities:

  

  1. You messed up the find | cpio copy command and not everything ends up where it should; the filesystem can't mount what it can't find!

  

  Solution: Using the live CD, reboot to a live session, manually mount both old and new, and compare and check the contents. You may need to back out and run the copy again.

  

  2. You messed up your /etc/fstab and didn't configure it correctly - I have done this.

  

  Solution: Using the live CD, reboot to a live session and open the etc/fstab file again. Check that you specified the right filesystem type – ext2, ext3 or Reiser. Check the device name according to your partitions – is your machine using sda or hda? Is the disk a, b, c or some other letter? Have you got the partition number right? Check the mount options - try 'defaults' in place of the nodev,nosuid options, as in:

  

  /dev/sdb2 /home ext2 defaults 0 2

  

  Of course, item #3 means you still can't identify the problem, in which case recovery is required.

  

  Boot up the live CD, go to a terminal, and type:

  

  sudo mkdir /recovery

  sudo mount -t ext3 /dev/hda1 /recovery

  sudo cp -R /recovery/home_backup /recovery/home

  sudo cp /recovery/etc/fstab_backup /recovery/etc/fstab

  

  And relax...

  

  There it is: /home on its own partition. You can do the same for any part of your filesystem if you want to segregate the contents - just don't think this takes the place of backups; regular backups are still crucial.

  

  Robin Catling occasionally earns money as a project manager, business analyst and technical trainer. He also coaches fencing in the New Forest, Hampshire, England.


  

  



  How To

  Create Your Own Server - Part 7


  Written by Daniel Lamb


  We are now going to install eGroupware onto your server. This will give us a groupware server which can function like Exchange by connecting an email client such as Thunderbird to it via IMAP, and connecting Sunbird to the calendaring service via icalsrv. First of all, we will need to copy icalsrv into the eGroupware installation folder. To do this, use these commands:

  

  wget http://downloads.sourceforge.net/egroupware/eGroupWare-1.4.004.zip?modtime=1208301229&big_mirror=1

  unzip eGroupWare-1.4.004.zip and now cp eGroupWare-1.4.004/icalsrv /usr/share/egroupware -r

  

  Now we can access the installer. In this example, we'll point to: http://yourserver/egroupware/setup/. The script will run through some pre-installation tests. Some of the items will pass and some will have warnings.

  

  Click the 'continue to the Header Admin' link at the bottom to continue. You should now be on the setup page. The 'Server Root' and 'Include Root' should be correct. You can leave the admin user set to 'admin' and create a password. This will be the account you use to login to the header manager. Change 'Persistent Connections' to 'False'. Scroll down to the database information section, and enter the information for the database you created in step #1. In this example, we'll use the following information:

  

  DB Type: mysql - Stays the same.

  DB Host: localhost - Stays the same.

  Skip the DB Port field

  DB Name: egroupware

  DB User: egroupware

  DB Password: mypassword

  

  This should be setup via mysql server settings within webmin.

  

  Choose a username and password for the 'Configuration User'. This is the account you'll use to manage the configuration. For this example, we'll use the same username and password as the header manager.

  

  Click the 'Write config' button to create the header file. You should get a screen saying that your header file was created.

  

  You should now be on the eGroupware login page for the control panel. Enter the admin information into the Setup/Config fields to login to the setup control panel.

  

  Click the 'Login' button to continue. You should now be on the setup screen for your eGroupware. It will tell you that the database is working but you don't have any tables installed.

  

  Click the 'Install' button to create the core tables. The script will create the core tables. If you don't receive any error messages, then it was successful.

  

  Click the 'Re-check My Installation' button to continue. The setup page will refresh and you'll see that all of the stages have been complete.

  

  Click on the 'Click here to setup 1 admin account and 3 demo accounts' link to continue. Enter the information you would like to have for your admin account. Check the 'Create demo accounts' checkbox to create the demo accounts.
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  Click the 'Save' button to save these settings. You should now be back at the eGroupware setup page. Click the 'Back to user login' link at the top left of the screen. If you get an error message saying that the lock function failed, create a support ticket on the help page with the name of your database, and lock access will be granted to your database. Refresh the page once lock access has been granted. You should now be at the login page. Enter the information you created for your admin account.
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  Click the 'Login' button to login to your eGroupware. You should now be at the admin control panel for your eGroupware management system. eGroupware is now installed.
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  Next month, we will discuss adding users and permissions on eGroupware, as well as any other issues anyone has with the install. Email Daniel with what you'd like to see done next with the server: daniel.lamb@openyourwindows.com

  

  Daniel Lamb owns and runs Flonix IT Solutions and is based in Perth, Scotland. He is also involved in a number of open source projects such as Moon Secure AV, Kantaris Media player, and open live support. He is also a committed Leeds United fan.


  

  



  How To

  Using GIMP - Part 4


  Written by Ronnie Tucker


  This month, we will discuss probably the most powerful feature of GIMP: Layers. If you can grasp the concept of layers and work them to your advantage, you can create anything. First, let's make sure we have our layers window showing and ready to use.
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  If you don't have the layers tab available to you, click File > Dialogs > Layers in the main menu.

  

  Here's how layers work: think of each layer as a transparent sheet of plastic. The idea is that you draw all your different things on separate sheets of plastic then stack the plastic sheets in a particular order to achieve your result. Similar to how an animator works. The background is on one sheet, the character on another sheet and any foreground details on a third sheet. Stack them properly and you will have the character with the foreground on top of it. Same with GIMP layers.

  

  If you open an image in GIMP, and display the Layers tab (or window), you will see that your image is displayed as a single layer with the name 'Background'.
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  Below the list of layers, you will see several icons. Think of these as shortcuts to menu options.
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  From left to right they are: Create New Layer, Raise Layer, Lower Layer, Duplicate Layer, Anchor Layer and Delete Layer. Those are pretty self explanatory.

  

  Using the selection tools from last month's article, I'm going to use the circle tool to select the planet.
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  And from the menu choose Edit > Copy, then Edit > Paste
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  You can see that I now have a new layer (named 'Floating Selection'), but it needs to become permanent, so click the New Layer icon. It now has a preview icon, and is automatically renamed to 'Pasted Layer'. If you want to rename a layer, just double click on its name, and enter a new name, followed by the Enter key.
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  If I hide the original 'Background' image, you can see that the selected, copied and pasted planet is now on its own, completely separate, layer. Our first new layer!

  

  TIP: You can copy from one image and paste in to another image.
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  Don't worry about the two-tone, chess-board pattern in the background. It's just there to signify complete transparency.

  

  So now, with the planet selected, I'll click the Duplicate Layer icon to give me a second planet. To move the layers, you use the Move tool, select the layer you want to move, then click and drag it into place. I'll use some of our color altering techniques to change the color of one planet to make it easier for you to differentiate between the two planets.

  

  TIP: If you have two images open, you can drag and drop layers between them!
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  Let's create a new blank layer.
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  A new layer is created above the layer you are currently on, so I'm going to select my (hidden) Background layer and then click the New Layer icon. Up pops the New Layer window (above).

  

  From top to bottom: We give the layer a name (preferably something descriptive! I'll call mine 'Space'); Width and height we won't bother with just now, as we want the layer to be the full size of the image; Layer Fill Type we will leave as transparent. You can choose white, or one of your foreground or background colors if you wish. Now, I'll make my foreground color black and fill my 'Space' layer with black color.
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  So now I have two planets out in space. I don't need the original image any more, so I select that layer and click the Delete Layer icon.

  

  So what if I wanted the orange planet in front of the blue planet? I click the orange planet layer, then click the Raise Layer icon.
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  Think of your layers as going from bottom to top. So first, GIMP lays down the 'Space' layer, on top of that it puts the blue planet layer, and, finally, on top of that the orange planet layer.

  

  When saving, you want to make sure you save your image in the GIMP format (XCF). The next time you load the image you will still have all the layers intact for manipulation. Saving as JPG or PNG will flatten the image and you will lose your layer information, so always keep an XCF version!


  [image: ]


  To save, you click File > Save As from the menu, and make absolutely sure the filename ends in .xcf.

  

  Many effects can be applied to layers to make them even more powerful. Try moving the Opacity slider (above the list of layers).

  

  Each layer can have one 'mode' applied to it. These are listed in the drop-down menu above the Opacity slider. Have a play with these effects. You can get some nice looking accidents with these modes.
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  Above is the basics of layers. No doubt, we'll talk more about them in future articles, but, for now, have a play with copying and pasting, raising and lowering layers, and moving them to create a pleasant composition.

  

  Next month, we'll delve in to measurements (and measurement types), rulers and cropping images.

  

  Ronnie Tucker is Editor of Full Circle magazine, a proud Kubuntu user, and part-time artist whose gallery of work can be seen at www.RonnieTucker.co.uk.


  

  



  How To - GRUB 101


  Written by Damon Rios


  For a variety of reasons, you may need to repair your master boot record (MBR). Some of the common reasons include:

  

  a) Installing or reinstalling Windows after you have installed your Linux system (you will boot right into Windows, without an option to use Linux).

  

  b) Using PartImage to clone partitions to a new drive, as explained in issue 12 (you will get an error message, usually “No operating system found”).

  

  c) Installing another Linux distro, and forgetting to configure the bootloader to not overwrite the MBR, something I typically do (you will get the new bootloader, which may not have your Ubuntu system as an option).

  

  Repairing GRUB

  

  Not to worry, if you have a live CD which contains GRUB. In eight steps, you will have your GRUB menu back.

  

  Steps 1 & 2:

  

  Boot the CD and open a terminal.

  

  Steps 3 & 4:

  

  Type:

  

  grub

  

  Then:

  

  find /boot/grub/stage1

  

  The output of the find command is important, as you will use it in Step Five. Alternatively, you could mount your partition, open /boot/grub/menu.lst (from the hard drive, not from the root of the live environment), scroll down to the uncommented line that says “root (hdx,x)”, close, umount, and continue. If you know which partition you need, you can skip this step.

  

  Steps 5-8:

  

  Type:

  

  root (hdx,x) <output of find command>

  

  Then:

  

  setup (hd0)

  

  Followed by:

  

  quit

  

  And finally:

  

  reboot

  

  What do steps 5 and 6 do? Step 5 tells grub what partition to boot from, and step 6 writes that information to the master boot record of the first hard drive.

  

  Modifying GRUB

  

  When you reboot into your system, open a terminal and enter:

  

  sudo <your favorite editor> /boot/grub/menu.lst

  

  Below are two example entries (for both Windows and Linux) that are included in the menu.lst file.

  

  # title    Windows 95/98/NT/2000

  # root    (hd0,0)

  # makeactive

  # chainloader +1

  #

  # title    Linux

  # root    (hd0,1)

  # kernel /vmlinuz root=/dev/hda2 ro

  

  Copy and paste to the bottom whichever you need, uncomment all of the lines (remove #), change the line “root (hd0,1)”, as needed, and give it a try by booting into your other partition(s).

  

  Damon Rios is finishing a Baccalaureate degree in Computer Information Systems. His area of specialization is networking, including setting up and maintaining servers, but he cannot stand programming. He has been using Linux (Ubuntu) for about a year, and has contributed to FCM as both a writer and a proofreader.


  

  



  Write For Full Circle


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives - Kubuntu, Xubuntu,Lubuntu, etc.

  Write your article in whichever software you choose - I would recommend LibreOffice. But, please spell and grammar-check it!


  The Official Full Circle Style Guidecan be read at:


  http://url.fullcirclemagazine.org/75d471


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.


  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!


  FOR REVIEWS:


  Games/Applications


  When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary - with positive and negative points

  


  Hardware


  When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary - with positive and negative points

  


  You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.


  

  



  My Story

  Ubuntu Saves The Day


  Written by Travis Moore


  Ubuntu saves the day! As clichéd as it sounds, Ubuntu has, once again, won my heart. I was at a friend's house, who at the time was doing a travel agency party/meeting. Her parents are starting up a travel agency website, which should be making nearly $1,000 (~£500) a week. Her mom, the main business woman, was fruitlessly trying to get her laptop to work with a VGA to HDMI converter, then a HDMI to DVI. Something was being lost in the middle of that, because all we were getting was the disappointment of a black screen. I said, “I know how to fix that.”

  

  I brought my laptop with a graphics card suitable for HDMI to DVI work. Of course, it was running Hardy Heron, and I also had Envy installed so that my Nvidia card would play nicely. I connected the HDMI cable, set it to TwinView, and it worked! Then I ran into another problem: the presentation that was going to be displayed was a Windows Executable file (not a plain PowerPoint Presentation). Thinking quickly, I installed Wine and was able to get the presentation working in a flash. Then another issue: the presenter wanted to use a clicker, you know, one of those wireless things that allow you to navigate presentations and such without having to use the mouse and keyboard. Well, I thought my luck was out, but I plugged it in anyway. I couldn't believe it, it worked! Then came a DVD, which I had already taken care of by installing libdvdcss.

  

  To make a long story short: the presentation went well. Hardy Heron, combined with Envy and Wine made all presentation problems vanish. I thank the teams who work on these projects.


  

  



  My Story

  From Mickey's ABC To Kubuntu


  Written by Andrew Min


  I'll admit it. I was always a computer geek. Ever since I threw a tantrum over my Mickey's ABCs game — Mom wanted me to get off, but I didn't — I've been involved with computers. But I really started getting into them when I discovered Microsoft Publisher XP, a program that tried to make desktop publishing easy for users. It never really took off, but I loved it. One day, I found out how to make a Web page. Then I decided to go to the library to learn how to create a better Web page. I picked up Dave's Quick 'n' Easy Webpages [1], and fell in love with programming.

  

  As I fell more in love with computers, I found more programming books. One day in 2003, I discovered an old O'Reilly book about Linux (can't remember the exact title). Unbeknownst to me, it had been written years before. I took a look at the book. It depicted a system that looked like DOS and included some screenshots of what must have been KDE 1.0. I decided then that I didn't want to run Windows 3.1.
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  A few years later, I had gotten into the instant messaging craze. However, I didn't want an official client. I wanted a client that ran AIM, ICQ, MSN, Yahoo and Skype, and included voice chat for each. And I found one: Kopete.
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  That was when I realized that it was only for Linux. Then I remembered hearing about something called VMWare being able to run Linux inside of Windows. So I searched the Virtual Appliance Marketplace [2] for "KDE" and found an openSuSE image. I downloaded it, ran it, and fell in love with KDE. There was a problem, however. I didn't want to replace Windows yet. And the virtual machine wasn't working, since I had only 512MB of RAM. I experimented with running Puppy Linux from a USB drive, but I gave up in disgust when I saw the JWM window manager. I also tried installing Slax, but back then it was much harder to install to a hard drive, and I gave up as well.

  

  Then in 2006, I found an article in PCWorld about Ubuntu. I read how easy it was to use, and decided it was for me. But there was one problem. I hated the brown theme. Then, I found out that there was a KDE sibling called Kubuntu. I immediately ordered five CDs of Dapper Drake from ShipIt.
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  It took months for ShipIt's package to arrive. When it did, I was so nervous that I kept putting it off. I finally summoned enough courage to install it on a Saturday in February 2007. Before I did, however, I learned that Edgy Eft had been released. I burned a CD and installed Kubuntu 6.06. It wiped my hard drive. Happily, I'd had the foresight to back up, so I reinstalled Windows XP and Kubuntu. In the process, I found out that Windows XP gets a lot faster if you reinstall it. But soon, I wasn't worried about Windows. Once Kubuntu was installed, I fell in love with it. The package manager (even SuSE's YaST isn't as good as aptitude), the stability (no crashes every five minutes), and the speed (contrary to my own belief, Kubuntu actually was faster than XP) combined to make it an operating system worthy of replacing Windows. Since then, I've tinkered around with different operating systems, but they all had problems -- MEPIS used outdated software, SuSE used an annoying YaST package manager, and Freespire was just all-round, bad. Kubuntu ain't perfect, but it's the best I've seen so far.

  

  Oh, and ironically, I don't even use Kopete any more.


  [image: ]


  [1] http://www.redwall.org/dave/davesbook.html

  [2] http://www.vmware.com/appliances/

  

  Andrew Min is a Christian, an American, a student, and a huge Kubuntu fanboy. Find out more about him at http://www.andrewmin.com


  

  



  Review

  HP Photosmart C3180 Printer


  Written by Ronnie Tucker
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  Having done my research for a nice, cheap, Linux-compatible printer, on Google and Ubuntu Forums, I decided upon the HP Photosmart C3180. It's an 'all-in-one' printer, meaning it can print (like a normal printer), scan (like a flatbed scanner) and copy (like an office photocopier). I should also mention that the copy function can be used even while the PC is off. Unlike the more expensive models, this one does not do fax.

  

  After powering on the printer and plugging in the USB cable to my PC, Kubuntu Hardy automatically detected the printer, told me it was a C3100 series from HP, and then displayed a printer icon [image: ] in my tray and also a bubble telling me it was configured and ready to use! It really was that easy. Clicking the printer icon gives access to the print jobs.

  

  After installing the black and color cartridges (which come with it), the printer automatically spat out a test page. This showed that the various colors were working effectively, as was the rest of the printer.

  

  Next, I opened a document in OpenOffice. I clicked print (above right) and it worked! Easy as pie. Then I decided to copy one of the pages I'd just printed. I put the paper on the scan area and pressed the copy button. It worked! By now, I was getting suspicious -- this was just too good to be true.


  [image: ]


  Getting the printer to scan caused me a few moments of head-scratching, but this was because I didn't have SANE installed. SANE is a scan application that effectively sits between other applications and the scanner. I installed and loaded up SANE, did a preview scan, selected an area, clicked scan and that was it! I loaded up GIMP and, after installing SANE, it now had the necessary option to acquire from the scanner.

  

  Looking at the printer itself, it has two main lights on top which alert you when the paper is out or the ink is low. It also has a number of buttons on it:
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  The copy buttons give you quick access to altering the paper type, the copy quality, the copy size, and the number of copies to produce. Below those are two more buttons for copying in color or in black. The last button is for scanning.

  

  On the front of the printer are several card slots:
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  These work just like a card reader, so my USB card reader is now redundant. Since there is no screen (to view your photos) on the C3180, you press the thumbnails button on the front of the printer (it flashes when you insert a card), and out will come a page (or pages) with thumbnails of your photos. Now, this is where we seem to find a Windows/Mac only option. The method is to fill in the page to select the thumbnails you want printed as photos, and then put the page into the scanner to enable it to detect (using OCR I assume) what you filled in on the page, and to print your request. How can this be done in Linux? I have no idea. The card slots still allow you access to your photos via GIMP or whatever photo album software you use.

  

  I'm not sure if it was always there, or added during detection, but I spotted an HP Device Manager (below) application in my Kubuntu menu.
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  This gives access to the main print, copy, and scan functions (with a handy function to let you queue up files to print), but also to status and supply reports (ink levels), tools (test pages, clean and align the cartridges), and print settings (for print quality).

  

  I really can't fault the printer at all. It installed so simply that I was suspicious of it. I tried all the basic features (printing, scanning, and copying) and they worked easily and flawlessly.
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  I bought my HP C3180 from eBuyer.com for £35 (~$70). New ink cartridges are approximately £15 each (~$30).


  

  



  MOTU Interview - Mathias Gug


  Taken from behindmotu.wordpress.com
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  Age: 28

  Location: Montreal, Canada

  IRC Nick: mathiaz

  

  How long have you used Linux and what was your first distro?

  

  The first time I saw linux was in 1997, Redhat IIRC. The first time I downloaded it was in September 1999, Debian. But I gave up after a couple of weeks. I came back during summer of 2000 with Mandrake Linux and the 2.4 kernel. I’ve never left since then.

  

  How long have you been using Ubuntu?

  

  I installed Ubuntu one and half years ago, it was Xubuntu 6.06 IIRC.

  

  When did you get involved with the MOTU team and how?

  

  I was hired by Canonical as the first member of the Ubuntu Server Team last May. I started packaging AppArmor and other server-related software — which led me to become a member of the MOTU team.

  

  What helped you learn packaging and how Ubuntu teams work?

  

  I’m using the packaging guide from help.ubuntu.com, the Debian New Maintainer Guide, and the Debian Policy. For processes, I just keep referring to wiki.ubuntu.com where they’re all outlined. And last, but not least, the irc channels (#ubuntu-motu and #ubuntu-devel), are great resources. I always find someone to help me there.

  

  Favorite part of working with the MOTU?

  

  Being part of a great team trying to deliver the best of the free software world. There are lots of interesting challenges when it comes to packaging - you get to learn how things work under the hood.

  

  Any advice for people wanting to help out MOTU?

  

  Start simple, start small. Pick one bug or one package and try to fix it. Ask for sponsorship, and you’ll learn a lot of things in no time.

  

  You have been working a lot in the Server Team, what can MOTU do to better the Ubuntu Server experience?

  

  One of the projects I’ll try to work on is a better packaging framework for web applications. So that such application can be added to the universe easily and in a consistent manner.

  

  Any plans for Hardy Heron?

  

  Most of them are in the server area - I’ll keep on working on security with AppArmor. Server hardware testing is another area I’m interested in.

  

  Favorite quote?

  

  “I am not an Athenian or a Greek, but a citizen of the world.”

  Plutarch quoting Socrates

  

  What do you do in your spare time?

  

  Among others things, I go swing dancing several nights a week, both in Montreal and in other places in North America. I’m also a big traveller: I’ve just returned from an eight month backpacking experience in Asia covering Mongolia, Tibet, Nepal and India.


  

  



  Ubuntu Women


  Written by Emma Jane Hogbin
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  For me, the Ubuntu logo represents freedom and community. The word itself means “Humanity towards others.” Within the Ubuntu community is a Code of Conduct (CoC) that governs our behavior [1]. It is simple and elegant. There are six main points in the code: Be considerate. Be respectful. Be collaborative. When you disagree, consult others. When you are unsure, ask for help. Step down considerately.

  

  Recently, the Ubuntu Women discussion list had an interesting exchange about the Code of Conduct entitled “How has the Code of Conduct Helped You?” [2] [3]. The responses showed a disconnect between our eagerness to sign the code, and our apathy towards upholding it.

  

  The Ubuntu community is full of life, and is a delight to participate in. Sometimes, though, I am not the epitome of the behavior defined in the CoC — whether it’s cracking jokes with friends in an IRC channel or engaging in passion-fuelled debate, I sometimes forget to rein myself in. When I slip, I enable others to slip too. This can start a domino effect of bad behavior that extends much further than the original interaction. By remembering to govern myself according to the CoC, I enable others to participate in the same way. I encourage everyone to join me in reading the CoC at the beginning of every month — let’s see how far we can spread the good behavior too!

  

  [1] http://www.ubuntu.com/community/conduct

  [2] https://lists.ubuntu.com/archives/ubuntu-women/2008-June/001594.html

  [3] https://lists.ubuntu.com/archives/ubuntu-women/2008-July/001598.html

  

  Emma Jane Hogbin builds and supports on-line communities using open source software. She lives in rural Canada and chronicles her adventures at www.emmajane.net.


  

  



  Ubuntu Youth


  Written by Uwe Hauck


  I am a long-term Linux aficionado. My first contact was in the early 90s with the early versions, but that was more of an academic interest as I was studying Computational Linguistics and Artificial Intelligence by that time, and, in my department, the OS of choice was Unix.

  

  I moved on, got married, had children, and about six years ago my interest in Linux grew again. My first contact was SuSE, but, with Feisty Fawn, I made the switch to Ubuntu.

  

  My wife was not so much into computers at that time; she was always fearful of viruses and catching Trojans while surfing the Web. So more as a joke, I said "Why don’t you try Ubuntu; it's safe, easy to use, and you'll love it". To my big surprise, she agreed, and I created a partition with Ubuntu Linux on our family desktop PC. Sure enough, she liked it, and became a computer addict, and the perfect match for a nerd like me.
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  We are running four machines at the moment — all equipped exclusively with Ubuntu, with the exception of the family PC, which still has one partition for Windows XP for those 'special' games the kids like so much. But there is hope. Our oldest son (aged eight) watched my wife the other day playing her favorite game, Widelands, and asked: "can I play it too?"

  

  First contact was made!

  

  I use a Sony Vaio VGN-FZ31J DualCore notebook, perfectly supporting nearly everything despite the NVIDIA graphics card, which works well but still waits for the dimming feature. In addition, I couldn’t resist buying an ASUS EEE PC 700 -- my sidekick in the office, and my surfboard on the couch. And it is great! Having installed Ubuntu on the EEE, I can do everything on the road. It even supports Compiz Fusion out of the box! It has become my media centre, portable video player, information centre (on the road), and much more. Even watching TV is possible with the Zattoo player or a DVB-T stick. At home, I add a USB keyboard, mouse and a 21 inch widescreen. To my big surprise, my little EEE PC even supports 1600x1050 resolutions! As soon as one of my kids needs a computer for their school work at home, they will get an EEE — or something similar — and for sure it will run Linux. With three kids, my reasoning is: for the price of one full-blown notebook we can afford three EEE PCs with additional keyboard, mouse and monitor. And you can always easily remove the PC from the kids room, should they spend too much time on the computer.

  

  At the moment, my kids use an Acer Desktop PC with an AMD Dual Core processor and a triple-boot setup with Windows XP, OpenSUSE 10.1 and Ubuntu 8.04. My wife uses my 'old' Notebook, a Samsung R55 DualCore, with - you guessed it - Ubuntu, and does a lot of correspondence, planning our social involvements, surfing the Web, and, of course, playing Widelands. We use a wireless print server, so anyone in the house can print on the family printer, a Canon MP750, via WLan.

  

  I have added an USB drive to our WLan router that acts as a network drive so everyone can access our music collection and the family documents from a single source. The EEE PC and my notebook run F-Spot, so we have our collection of family photos with us all the time, and they become great high-tech picture frames in screensaver mode, flipping through our family album. I have Firefox with Foxmarks, so whatever computer I use, I have all my bookmarks with me.
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  Our family calendar runs on Google Calendar, and with Thunderbird, Lightning and Provider running on each computer, we all have our family dates in sync, everywhere. I can even check if my extra office hours fit with the family schedule, and I can update my business dates without having any private dates on my office computer.

  

  And I am running GCalDaemon for Evolution on my notebook, with multisync and the Bluetooth plug-in for Sony Ericsson phones. That way I can keep the calendar and addresses on my mobile phone automatically in sync with the family calendar on Google whenever the phone comes into the Bluetooth range of my notebook.

  

  And of course, the whole family is equipped with Ubuntu merchandise. Why? So no one can miss the fact that we are an Ubuntu family. And, through several talks, I have already convinced about five of our friends and my colleagues to give Ubuntu a try and, yes, three have made the switch, one of them completely.

  

  Uwe Hauck is a software developer and Ubuntero, participating in translations, bug fixing, and trying to convince as many people as possible to try Ubuntu. He lives in Schwäbisch Hall, Germany, and is married, with three kids.


  

  



  Letters


  I started using Ubuntu in June of 2006 (Dapper Drake) because I hated Windows' proprietary stuff. I got tired of not being able to fix bugs myself and not being able to get updates until Tuesday of the following week. I finally said "forget this" and went on a search. I found SUSE Linux first, but due to its non-user-friendly approach I went searching again. I finally came across Ubuntu and, of course, when I first began using Ubuntu I had a few problems - one or two compared to Windows thousands. Then I found Ubuntu Forums and the beginner team. Those guys helped me so much! Since first using Ubuntu - until today - I have great appreciation for the Free and Open Source community and developers. Ubuntu is awesome, and I do not believe I will change because of the amazing support from the community and Canonical.

  

  Alan Munson


  


  

  In issue 13 Alessandro mentioned that his friend's laptop worked better with Ubuntu. I'm not going for any case badges here, but Ubuntu works better. At this moment I run a Ubuntu 8.04 server, Ubuntu 7.10 on my desktop and Ubuntu 8.04 on my laptop. To make a long story short, on the desktop, the HP-5L laser printer prints better in Ubuntu, the tv-tuner works seamlessly (in Windows its proprietary drivers have a sound problem), and that's not all because the sound card drivers from Ubuntu send a better signal to the speakers. And it is all for free, free as in free speech of course, but in this case it's free as in free beer.

  

  I've been dual booting Windows and Linux since 2004 but Ubuntu got me Windows free about 6 months ago. Last month I even got a friend of mine to switch to Ubuntu 7.10 on her old PC. It's just a small deed for what Ubuntu gave me instead.

  

  Ciprian


  


  

  I think a useful article for a future edition should cover the GRUB bootloader as my recent experience proved, without this piece of software working, the computer is useless:

  

  I got the Windows Paragon Partition Manager last week to get back space required for XP from one of the two Ubuntu partitions - on the first laptop this worked fine, Paragon brought the message to reboot to complete which it did in the blue checkdisk screen in XP.

  

  However in the second laptop, Paragon decided to complete within XP and on rebooting I just got a message about GRUB loading but with error 17 (whatever that means). I only got things up and running again by booting the Ubuntu CD, manually deleting the Ubuntu partitions in the setup and letting it complete to reload the boot menu. Now everything works fine again and I achieved the extra space I wanted for XP.

  

  A few gripes I've got about Ubuntu are: the boot menu gets more and more versions added - how do I delete those that don't apply and don't exist anymore or never used?

  

  With the latest upgrade to 8.04, the radio players don't work any more so I've given up with this as it took me so long to sort out the players with previous versions up to 7.10 which worked.

  

  I downloaded GParted in Ubuntu, but couldn't figure out the program to delete and resize partitions, with no help menu, and it didn't seem very user friendly like Paragon's.

  

  Each week there's more and more space required for security fixes and upgrades in the latest 8.04 version, seems like it's averaging 80Mb a week, so eventually I thought I'll be running out of disk space, especially as previous versions are kept in another partition automatically - so I'm sticking with XP instead for less updates, a higher resolution display, and a far less complicated way of getting programs without worrying about some meaningless file names that are going to be uninstalled if I install another program in Ubuntu. Uninstalling in Ubuntu risks disabling the whole computer without any warning notices so I've given up on this after one disaster.

  

  I'll be back with Ubuntu when these have been resolved, but in the meantime I'm for an easier computer experience (life) with XP, where I don't have to think that much or worry whether the laptop will reboot again after the latest changes.

  

  Michael

  

  Ed: Your wish is my command. This issue (page 18) has an article regarding GRUB and it's many options.


  


  

  Just a suggestion for the magazine: how about an article explaining clearly how to deal with tar.gz, BZ2 etc. I know it is in the docs, but it is quite confusing for a beginner.

  

  I think it would be nice and very useful for the community.

  

  Alain

  

  Ed: Thanks for the idea Alain, we'll certainly take it on board and hopefully get something written up on archives in the very near future.


  

  



  Q & A


  Written by Tommy Alsemgeest


  
    	Q If I download files to Linux, can I transfer them to Windows XP? If so, how? And can I run them? I use Linux Mint (Ubuntu based distro).


    	A Yes, you can easily transfer them - by copying the files across to your XP partition or drive from within Linux. You can access your Linux partition from within XP by installing the ext2fs driver in Windows.


    	



    	Q When I try to watch a video in Firefox (in Hardy Heron), I get audio but no video. Any idea how to fix this?


    	A Firefox is probably missing a plugin. Take a look here: http://ubuntuforums.org/showthread.php?t=766683.


    	



    	Q What should I do when I get the error: fsck died with exit status 8? Nothing appears to be broken; however this error is holding up my boot sequence, until I hit Ctrl+D to continue.


    	A You can fix it by running e2fsck from the live cd, or by running it with the -f flag, like this:


    	

    sudo e2fsck -f /dev/sda1


    	



    	Q I have downloaded a shell script file. When I try to open these files, nothing happens. What program should I use to open these files?


    	A Set the SH file permission first to executable


    	



    	chmod u+x /path/some_linux_installation.sh



    	



    	Then run it with:


    	

    sh /path/some_linux_installation.sh


    	

    or:


    	

    ./some_linux_installation.sh


    	

    


  


  My Desktop
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  I've used Ubuntu since Dapper, and now use Gutsy with Compiz Fusion and Emerald - on a Core 2 Duo 2x2.2 GHZ with 1GB of RAM and an nVidia GeForce 8600GT. It runs like a charm. I plan to upgrade to Hardy as soon as the Final hits the Servers.

  

  I used the wonderful looking Buuf icon theme from gnome-look.org. The Emerald theme was mixed using System-Colors, the dockbar is the Avant Window Navigator. For the Wallpaper, I went to theinspirationgallery.com?, and found a pattern, and edited it to a Victorian-style dark background image.

  

  Björn Haubrich
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  I am using a 10 year old Daewoo, Pentium III, 1.0GHz, 384 MB RAM, 20GB HD. It has so many hardware problems that it takes several tries to properly start Ubuntu. But once it starts, the machine becomes alive! I mean, I can do so many things with it I don't want to let it go. I enjoy Ubuntu, and I love that I have the option of changing its appearance.

  

  My theme is a custom collection made up of the following: Black Plastic (for controls), Vista Mix Dark (for window borders), and Human Default (for icons). I found everything, including the background, at gnome-look.org

  

  Tsegaselassie Tesemma
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  Presently, I have Ubuntu 7.10 installed on an Acer Aspire notebook: 1.60GHz, dual-core, 1GB RAM, 80GB Hard disk, WiFi, and Bluetooth.

  

  I have a highly customized and personalized installation. The appearance aspects are: Compiz Fusion with the Emerald window border decoration. Icons are OSX, and the control theme is Aero-clone. The default panel is neatly tucked away on the top left. Cairo-clock is at the bottom left. AMSN messenger is there too - with the aMSN live skin. And PCMan File Manager for tree structures and fast access. At the bottom centre of the screen I use AWN curve to move between running applications. Applications can be launched from the menu accessible with Super L+Alt key.

  

  Muhammad Umar
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  Relatively little has been tweaked to achieve this look of my Ubuntu 8.04 desktop. Icons are the 'Tango-style' theme found on gnome-look.org. The wallpaper is from Interfacelift.com. The window borders are a modification of 'Humanoid OS X Dark', also on gnome-look.org. I modified it to inherit the color of the buttons from the GTK theme colors, and to show a more neutral border on the inactive window - to make the active window more easily distinguished from the rest.

  

  The GTK theme is the standard theme Clearlooks, with colors chosen to match the icons and wallpaper. Drop shadows are due to the Desktop Effects, as is the transparency of the screenlets. All running on my trusty Lenovo 3000 n100.

  

  Thøger Thorsen


  

  



  Top 5 - Slim Web Browsers


  Written by Andrew Min


  Epiphany
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  Homepage: http://www.gnome.org/projects/epiphany/

  

  Epiphany (also known as "GNOME Web browser") is one of the best Web browsers for Gnome users. Based on the now defunct but formerly popular Galeon, Epiphany has full Gnome support, has tons of extensions, uses the standards-based Gecko browser engine, and is, overall, a fully functional Web browser. While you probably wouldn't use this baby in KDE, Epiphany is a wonderful tool if you're a Gnome user who is sick of Firefox's bloat but still want feature-rich browsing.

  

  When installing Epiphany, do not use the epiphany package unless you want a Boulder Dash clone. Instead, you should install the epiphany-browser package in the Universe repository.

  


  


  Dillo
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  Homepage: http://www.dillo.org/

  

  If you like simplicity, Dillo is perfect for you. It's one of the ugliest applications I've ever seen, but it takes up the smallest amount of window real estate I've ever seen. It's also lightning fast, but that's mainly because it doesn't support Java, JavaScript, or CSS. Heck, it can't even display some characters! Think of it as a graphical Lynx, except that it can display images. That's not to say that Dillo is useless, however. It's perfect for just getting information when Firefox is slowed to a crawl, and you want the info now. Yes, I'm American.

  

  To install Dillo, use the dillo package in the Universe repository.

  


  


  Arora
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  Homepage: http://www.arora-browser.org/

  

  This simple, cross-platform browser is one of my favorites on the list, mostly for its speed. It's blazing fast - even faster than Firefox 3 in my informal tests. It also looks great in both KDE and Gnome. And, for a project with less than 10,000 lines of code, it's got quite a few features, including tabs, bookmarks, and history. You do need to note that it is a tad unstable (it's not even in alpha yet).

  

  Since it's not stable yet, Arora isn't in the Ubuntu repositories. To install it, add the Backport repositories (go to Software Sources and check "Unsupported updates" in the Updates tab), and then install the latest .deb from the Arora homepage.

  


  


  Midori
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  Homepage: http://midori.sourceforge.net/

  

  For those who liked Arora's fast, lightweight, WebKit-powered engine, but didn't like Qt, Midori is worth a go. Since it's WebKit, it's blazing fast. And it also has quite a few features - tabs, lots of interface customizability, proxies, and a very handy form fill. However, it still manages to stay light and unbloated - a lesson many other browsers should take note of. Note that, like Arora, it is definitely heavy alpha, so only the brave should install it.

  

  To install Midori, grab the midori package from the universe repository. You can also grab the midori-dbg package if you're having some problems debugging it.

  


  


  Kazehakase
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  Homepage: http://kazehakase.sourceforge.jp/

  

  WebKit is blazing fast, but often renders pages incorrectly. Gecko (Firefox's engine) renders everything except ActiveX, but is fairly slow. That's where Kazehakase comes in. Unlike most browsers (which only have one engine), Kazehakase has support for both Gecko and WebKit, with more engines like GkHTML, Dillo, and w3m to come. It also includes a very powerful GTK interface, complete with different levels of complexity (Beginner, Medium, and Expert), bookmarks, and much more.

  

  To install Kazenakase, use the kazehakase package in the universe repository. In Intrepid, you'll also have to choose between kazehakase-webkit and kazehakase-gecko, since the Hardy version supports only Gecko.


  

  



  ﻿FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles and Full Circle is no exception. We need your Opinions, Desktops and Stories. We also need Reviews (games, apps & hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or suggestions, you may have.


  We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki:



  http://wiki.ubuntu.com/UbuntuMagazine


  Please email your articles to:

  articles@fullcirclemagazine.org


  If you would like to submit news, email it to:

  news@fullcirclemagazine.org


  Send your comments or Linux experiences to:

  letters@fullcirclemagazine.org


  Hardware/software reviews should be sent to:

  reviews@fullcirclemagazine.org


  Questions for Q&A should go to:

  questions@fullcirclemagazine.org


  Desktop screens should be emailed to:

  misc@fullcirclemagazine.org


  ... or you can visit our forum via:

  misc@fullcirclemagazine.org


  Full Circle Team:


  Editor - Ronnie Tucker -

  ronnie@fullcirclemagazine.org


  Webmaster - Rob Kerfia -

  admin@fullcirclemagazine.org


  Comms Mgr - Robert Clipsham -

  mrmonday@fullcirclemagazine.org


  Podcast - Robin Catling -

  podcast@fullcirclemagazine.org


  Editing & Proofreading:


  Mike Kennedy

  Lucas Westermann

  Gord Campbell


  Our thanks go out to Canonical, the many translation teams around the world and to Thorsten Wilms for the current Full Circle logo.
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